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Are you Ready? 

 
 

At this point, we assume that both EndNote Version 6 or 7 and Microsoft Word or 
WordPerfect are properly installed on the computer.   
 
Refer to Method 1 in the Start EndNote section below to see check if EndNote 
is installed and what version. 

Start EndNote 
EndNote is a regular program so it can be launched in the usual way you launch 
programs. 
 
Here are two alternative methods for starting EndNote. 
 
Method 1: 
 

Word: click on the Tools menu and the first choice should be EndNote6 
or EndNote 7.  

WordPerfect: click on the Tools menu and the choice EndNote 6 or 
EndNote 7 is in the middle of the pull-down menu.   

 
If the choice is not present or it is an older version of EndNote then please 
contact your Computer Support Person (CSP).  
 

Method 2: 
 

Double click an EndNote Library icon. 
 



 

What Should I see when I open EndNote 7? 
 
When EndNote opens there will be Menu Items and hopefully the Main toolbar. 
 

 
 
 

No Main Toolbar 
 

If the main toolbar is not active you can activate it yourself. 
 

1. From the Menu Items choose Tools 

2. Slide cursor down to Show Toolbar 
3. This reveals the toolbar list 

• Main 

• Text Style 

• CWYW/ Add-in 
4. Slide cursor over and choose Main. 

A checkmark in front of the toolbar name means it is already active. 
 
Note: To hide a toolbar repeat steps 1-4. 
 
 

Toolbar descriptions 
 

The Main toolbar: 
 
 
 

Main Toolbar 

Current Style Field

 

Menu Items 

 
 

 New Library 
 

 Open existing Library 
 

 Print selected Reference(s) 
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Cut Selected text or delete selected Reference(s) 
 

 Copy Selected text or selected Reference(s) 
 

 Paste Copied text or Reference(s) 
 

 Activates EndNote’s Search Engine for searching a library.  For more 
details, see page 10. 
 

 Sort Library.  For more details, see page 21.  
 

 New Reference.  The reference will be placed in the active library when the 
button is pressed. For more details, see page 5. 

 
 Connect to a database such as PubMed.  This button will launch the 

Connection Manager and needs an Internet connection. For more details, 
see page 7. 

 

 Import.  Brings in the results of a search from another database saved as a 
txt file following the proper steps. More details. 

 
Export.  Exports your library as a text file for use with other applications. 

  
 
Current Style Field displays the style name that was last 
selected.  This style will be applied by the Cite While You 
Write function and will be the selected choice when Format 
Bibliography is chosen.   

 

 
The Text Style Toolbar: 
 
 
 

 
 

 
 
 
 

Symbol Font

SubScript

SuperScript

Bold

Italics

Underline

Plain

Choose  
Font Size 

Choose a 
Font 

 
The Text Style toolbar is used when editing a reference in your library.  It 
does not affect the text in your document.  
 
The Text Style toolbar is also used when building a custom journal Style or 
editing an existing journal style. 
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Starting from Nothing 

 
EndNote is most effective when used from the beginning of the paper writing process.  
It can insert and organize the citations as the paper is created, which makes 
everything more efficient during the formatting phase.  
 
To take advantage of EndNote's efficiency, begin with Microsoft Word open and follow 
these steps to build your first EndNote reference library. 
 

Creating a New EndNote Library 
 

1. From Word’s menu, select Tools and EndNote 7.  Then slide over and choose 
Go To EndNote. 

or 
1. Click the Go To EndNote button on the EndNote Toolbar. 

2. At this time EndNote will want to open an existing Library. 
 

• If one does exist,  

1. Select the Open choice  

2. browse on your computer to find the library and 

open it. 

• If one does not exist or as in this exercise a new 
library is desired then: 

 
1. click the Create a New button  
 

3. This brings up the new library window. 

a) Select the location on your computer where the library will be stored. 
b) Type in the name of the new library.  

• PCs will automatically add .enl as the extension 
c) Click on Save. 
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A new, empty EndNote library file is created.  It can be identified by the title 
appearing on the top of the window. This library can be treated like any other file 
on the computer such as a Word document or an Excel file.   

 
 
 
 
 
 
 
 
 

File name displayed on top of Library window 

Windows Macintosh 

The EndNote library is a database file.   
 

Two characteristics of the database are: 
a) The file automatically saves every change in data you make. 

• So you cannot work/practice/experiment on a library for a while 
and then decide to close without saving, because the changes 
will already be recorded. 

If you need a practice or experiment library then make a copy of the library and 
use that. 
 

Adding References to the Library 

 
There are three different ways to add references to the new library: 

 
1. Type them in yourself 
2. Connect to the database through the EndNote program  
3. Import them from a properly saved text format file from an on-line 

database query made through either Netscape or Internet Explorer 
(see Appendix B) 

Any question concerning on-line database searching features of the web, please 
check with Larry Wright of the NIEHS library staff for assistance.  Basic 
information is provided in Appendix B of this manual. 
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Typing References manually 
 

At times it is necessary to directly type in a reference.  An example of this is 
when the article is old and the archives have not generated that year on the 
database yet. 

 
1. To add references to the library, pull down the References menu item and 

select New. 
 

2. Select the Reference Type from the drop down menu near top 
3. Type in the reference information for each field.  As with most databases, 

use the Tab key to move down the fields, the Shift + Tab keys to go back 
a field, or click the mouse in the next field.  Each field can contain up to 
eight pages of text. 

4.  
Enter only one author on each line--so press the return key after each author.  
The method used to enter names in other references in the library does NOT 
matter.  The important issue is to remain consistent within the individual 
reference.  When entering an author's name use the following guidelines. 

 
1. Name can be entered as either: 
 

a. Last name, First Middle Ex. Thoughtful, Toby Simon 

b. First Middle Last Ex. Toby Simon Thoughtful 
 

2. It is best to enter full names because EndNote can abbreviate when needed, 
but if only initials are available then they can be entered two ways. 

 
a. With periods  Ex. Thoughtful, T. S. 

b. Without periods and a space between Initials 
 

 Ex. Thoughtful, T S 

 Ex. T S Thoughtful 
 

c. If there is a title with the name it follows the name after a comma 
 
 Ex. Thoughtful, T. S., Jr. 

 Ex. T S Thoughtful, Jr. 
 
Note:  Closing the reference window automatically saves it into the library. 
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Connecting and Importing References within EndNote 
 

Searching through EndNote is the best method for building your first library.  
Especially when converting all references that have only been hand-typed and 
never used in a bibliographic data base software program such as EndNote or 
ProCite.   
 
It is quicker to locate these already known references using EndNote to connect 
to PubMed than to manually enter the information and an added bonus is that the 
information imported from PubMed will be more extensive--including things like 
the full abstract. 
 
Follow the steps in this section to build the library with your existing typed 
references or hard copy articles as your starting point.  DO NOT use EndNote to 
connect to other databases when performing new searches of references on a 
particular subject, key word, author or publication.  When you are not sure of the 
outcome of the search the lack of accuracy in EndNote's search engine will go 
unnoticed and important references will be missed!  
 

Note: To do a proper first time search or update a search of topics or authors, please 
refer to the classes offered by Larry Wright of the NIEHS Library:   
http://dir.niehs.nih.gov/cgi-bin/roy/class.pl or refer to Appendix B of this manual. 

 
The shortest way to get known references from an on-line library is to use the built-in 
Connect feature of EndNote. 
 

1. From the Tools menu, choose Connect. 
 

2. When the menu opens, If a library has been used before it will appear 
below the Connect . . . choice and can be selected at this time.  If the 
desired library is not listed here choose Connect. ...   
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3. The Choose a Connection window opens.   

 
 
 

4. For the sake of this exercise choose the PubMed (NLM) connection 
either by double-clicking to activate it or a single click on the name and 
then click on the Connect button.  
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Two new windows will open on top of your EndNote library. 
 

The first window is the EndNote's Search screen. 
 
The other is the temporary library connected to the database you've just 
chosen.  This window will hold your search results before you transfer them 
to your library.   

 

Temporary 
PubMed window 

Search Engine 
window 

 
 

Common EndNote Search Engine Error 
 

The EndNote Search engine will search any library that is active. The search 
window tells you which library it is searching at the window top. 
 
 

2 

1 There are two libraries open: 
 

• PubMed MEDLINE 
• Library_Name.enl 
 

Check the top of the Search window 
to see which one it is searching. 
 
Example 1:  The search engine is 

searching the PubMed 
MEDLINE library. 

 
Example 2:  The search engine is 

searching 
Library_Name.enl 
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Explaining the Search Engine Window 

A 

C 

D 

B 

F
E 

 
 
 

A. The title of the library being searched. 
B. Above each field is the search criteria and it defaults to Any Field.  

One click on the double arrows reveals a list of field criteria such as 
Title, Author, Year, etc. 

C. Next, choose the And, Or, or Not radio button between the search 
fields. 

D. Save the details of a specific search that will be repeated often.  Load 
a previously saved search for quick searching. For more detail see 
page 14. 

E. To stretch the window to reveal added search fields put cursor over 
lower right corner.  When cursor changes shape click, hold and drag 
the window to desired size. 

F. This option is to Add, Insert, or Delete an entire search field.  These 
choices are available across the top right of the window. 
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Using the EndNote Search Engine 
 

1. For this exercise, type in birdseed in the first search field and leave the 
search criteria on any field.   

 

 

Note: In searching for your real references, try using Author, Year and Title as your first 
criteria. 
 
 
2. This query finds nine matches out of all the on-line references in PubMed.  

The computer indicates the results in the Confirm Remote Search  or  
Search Complete window. 

 
 
 
 
 
 
 

 
 
 

PC window Mac window 

Note:  If there was a previous list of references in the temporary PubMed window the 
Discard option will be available.  If the previous list has been examined and the 
needed references copied to the permanent library then choose Discard.  This 
clears the temporary window and saves time when viewing the new references. 
 
3. Retrieve the found references. 

• If the found set is large choose cancel and narrow the search criteria 

• If the found set is satisfactory, click on OK. 

 
4. The temporary PubMed library (the Connected to: window) 

• now has all retrieved references showing. 
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• provides a location to view, examine and choose which references are 
desired for the new library.   

 
• The references are not yet part of your new library. 

 

 

 

5. Examine the references from the temporary PubMed window. 

• Sort a list in any library window click on the column label, such as 
Author, Year, or Title, and the references will be sorted by that 
category. 

 
• To examine a reference in more detail, double-click on it and a 

reference window will open and allow viewing of all fields. 
 
• If all references are highlighted, it will open windows for each. 

 
6. There are three methods to select references to move to the new library: 

 
a) To import them all 

1) pull down the little arrow 
next to Copy All 
References To (located 
in the upper right of the 
window) 

2) slide down to the last 
choice which will be the 
title of your open library. 
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b) To select a continuous group of references: 
 

1) click on the first reference 
2) hold down the Shift key 
3) click on the last reference of the group 

 
c) To select several entries scattered throughout the temporary PubMed 

window (Connect to: window) 
 

1) click on the first reference, hold down the Control (CTRL) key 
on a PC, or the Apple Command ( ) key on the Mac 

2) continue to hold down the Control (CTRL) key on a PC, or the 
Apple Command ( ) key on the Mac and click on all the 
references to be copied to the EndNote library. 

3) deselect a reference by clicking it again while holding the 
Control (CTRL) key on a PC, or the Apple Command ( ) key 
on the Mac 

7. Two methods for moving the references to your library 
 

a)  
1) pull down the little arrow next to 

Copy n References To (located 
in the upper right of the window) 

2) slide down to the last choice 
which will be the title of your 
open library. 

b)  
1) Put cursor over one of the highlighted references. 
2) Click, hold and drag the references to your library and release. 

 
 

Note:  A shortcut for copying selected references is to click, hold and drag the 
highlighted references in your library into your library window and let go. 

 
 

8. When all the references are found and the library is complete, end the 
connection to PubMed by closing the temporary Connected to: PubMed 
window and tell it to Discard this information.  Remember that the PubMed 
connection is live and using space on that library server.  It is professional 
courtesy to end the connection to make room for someone else when you are 
finished. 
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9. Close the Search window, which leaves only the new EndNote library 

window. 
 
 
 
Note:  If using an already established EndNote library with references preexisting in it, 

your library now only shows the newly imported records and none of the old 
ones.  Choose References from the menu items and select Show All so that 
you may see your entire list of references. 

 

Save/Load searches 
 

The Save and Load buttons are at the top left of the search engine window. 
 

· To save the details of a search: 

a. configure the search window 

b. then click the Save button. 

c. When the save dialog appears enter the name 
d. click Save. 

 
· To load a search 

a. make sure the library and the search engine window are open 
b. click the Load button 
c. When the dialog window opens select the search strategy 

wanted  
d. click Open 
e. The search window will be automatically be configured to reflect 

the search  
f. click Perform Search. 

 

Some of my references have disappeared 
 

This will most often occur after a search or import action. 
 
EndNote only shows you the references involved with the action performed. 
 
On the library window EndNote tells you if a subset is being displayed. 
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• PC this is located in the lower left of the window 
 

• Mac this is located in the 
upper middle below the title. 

 
 
 

Windows 

Macintosh 

To reveal all the references 

1) From the menu items choose REFERENCES 
2) slide down and choose SHOW ALL 
3) Keyboard shortcut is: PC = Control (CTRL) + H 

Mac = Apple Command ( ) + H 
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Importing On-line Queries 
 

Many begin with the research portion of the work completed, such as searches on 
MEDLINE using Web of Science, or PubMed. This search usually generates a saved 
file from the query that will be used in a paper.  Detailed instructions on how to do 
searches on PubMed and Web of Science are taught bi-monthly by Larry Wright of the 
NIEHS Library.  Please check the Computer Training schedule for the next available 
class at the http://dir.niehs.nih.gov/dirosd/training/home.htm web page.  Basic 
instructions for searches are Appendix B of this manual. 

 
NOTE: It is highly recommended to go directly to the databases (such as Web of 

Science or PubMed) when generating a new or exploratory search.  Do not 
use EndNote's Connection when searching these databases.  There is a 
drop-off in searching accuracy that is not readily apparent without a 
comparison of methods.   

 

PubMed 
 

1. In PubMed, be sure to display the selected search results/ 
references in MEDLINE format (Note: the default format is at the 
top of the web page is Summary and it will not work with EndNote.) 

2. Once the references are displayed in MEDLINE format, click on the 
Save button and save as a text (.txt) file. 

3. Go to EndNote and open your library file. 
4. From File menu item, select Import. 
5. In the Import dialog box, the first step will be to Import Data File. 

Using the CHOOSE FILE button, select the text file that you just 
saved in PubMed. 

6. The second step is to select an Import Option. For PubMed, select 
Other Filters... Then highlight the PUBMED (NLM) filter and click 
on the CHOOSE button. 

7. Click on the Import button. 
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Web of Science 
 

1. Mark references and click SUBMIT button. 
2. Click MARKED LIST button (near top of screen) 
3. Click SAVE TO FILE and save the references as a text (.txt) file 
4. Go to EndNote and open the library file. 
5. From File menu item, select Import. 
6. In the Import dialog box, the first step will be to Import Data File. 

Using the CHOOSE FILE button, select the text file that was saved 
in Web of Science. 

7. The second step is to select an Import Option. For Web of 
Science, select Other Filters...  Then select the ISI Web of 
Science filter and click on the CHOOSE button. 

8. Click on the Import button. 
 
 

Opening and Editing a Reference in an EndNote library 
 

There are different ways to select a reference  

• scroll to and click on the reference using the mouse 

• typing the first few letters of the author’s last name 

• using the arrow keys to move the highlight up or down the library.   
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Locating a reference in a large library 
 

When the library becomes large the method of typing in the first letters of the 
author's name to locate the reference is most efficient.  This method only searches 
the first column, which defaults to the author category. Directions to change display 
fields are in the Changing Preferences section. (Page 37).   

 
1. Select Malik reference by typing mal without pausing between letters.  

Pausing between the letters takes you to the alphabetic sections of m, then a, 
and then l separately with each keystroke, pause, keystroke. 

 
 

 
2. The scroll bar to the right of the window is also useful for moving up or down 

the library 
 
3. The up and down arrows on the keyboard will also move you through the 

library. 
 

Open a reference 
 

Use any of these methods to open the selected Malik reference: 

a) press return 

b) double clicking on it 

c) from the References menu select Edit 
All of the information associated with this single reference is displayed in the 
Reference window.   
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Use the mouse on the scroll bar to view the information or advance by using the 
tab key.  Shift+tab moves back to a previous field in the record. 

 

Editing a Reference 
 

All of the fields in the reference window can be edited.  To edit the fields:   
 

1. Click the mouse at the desired location to insert the text cursor (which is 
the blinking vertical line). 

 

 
2. Now most word processing functions are available including pasting a 

large amount of text (up to 8 pages) into a field. 
 

Leave the text plain without any formatting.  This makes the transfer to the specific 
journal styles easier. 
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Keywords field 
 
You can add your own keywords to this field.  

1. Click in the field to place your cursor 
2. Type in the keyword(s) Imitate the same pattern that exists. (usually 

one per line) 
 

Adding Keywords to multiple references at the same time. 
This is useful for future retrieval of these references from a large library. Also useful 
when importing a specific search or preparing for an upcoming manuscript. 
 

1. Select all the references that you want to edit 
2. From the References menu choose Show selected references 
3. Check the Showing numbers in lower left (PC) 

or upper middle (MAC) to be sure only your 
subset is active. 

4. From the References menu choose Change and Move Fields 
5. Change the Field from Author to 

Keywords 
6. Select the insertion choice (usually insert 

after field’s text) 
7. Type a space and then the keyword. 
8. Click OK 
9. A warning dialogue will appear, click OK 
10. Click OK on results dialogue 
 

Notes Field 
Use the Notes field to keep any thoughts or reflections about the article.  Include 
any important ideas that will trigger your memory when reviewing the reference 
at a later date.  
 

1. Click once in the Notes Field 
2. Type and delete as desired 
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Sorting References in Your Library 
 

Each user has personal preferences on how to view the references.  EndNote 
offers the flexibility to sort any library according to current needs. 

 

Quick sorts 
 

Quick sorts are done by clicking on the category label at the top of a column.  
This sorts by the field chosen and defaults to ascending order, but can be 
changed to descending by clicking the same category label a second time.  

 

 

 

Advanced Sorting 
 

A more extensive sort is done by: 
 

1. From the References menu item, select Sort. 
 

2. The sort window offers a five-level sort.   
 

3. Click the arrow in the Author field to select the heading by which you 
would like to search. 
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4. Select the most important field. If there is a logical conflict between the 
sorting the field that comes first takes precedence.   

 
5. The Box to the right of each field decides if the order is ascending or 

descending 
 
 
 
 
 

Descending Ascending 

6. Repeat steps 2-5 for each desired field. 
 

7. Click the Sort button and the references in the library will be re-
ordered according to the choices. 
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Finding Duplicates 
 

1. To check for duplicate records, do the following:  
from the EndNote menu, choose References, Find 
Duplicates. 

 
 

 
 
 
 
 

The Results of a Find Duplicates action: 
 

• EndNote will show only those records it finds as duplicates. 

• It automatically highlights the latest copy of the reference. 

• It is very important to check the references against the Word 
document to make sure a cited reference is not deleted.  Recall the 
citation example: 

 
This is my great new idea and another study that agreed 
with my findings{Bull, 1976 #9}. 

 
The #9 inside the braces refers to the reference number. Each 
reference is given a unique number when created in the library.  When 
a reference is deleted its number is never reassigned.   

• If at this time you are positive the highlighted references have not been 
used then delete them.  If unsure proceed to the Check record 
numbers of references section below. 

 
• Methods to delete a selected reference(s) 

 
1) from the menu items choose References and then Delete 
2) from the menu items choose Edit and then Clear. 
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3) The quick keys  + X or  + D for Macintosh or CTRL + X or 
CTRL + D for PC will also work.  

 

Check record numbers of references. 
 

1. If the Rec # category is 
displayed in your library 
use it to make the 
comparison. 

 
 
Note: To have the record number displayed in the library window with each reference 

see the Library Preference section on page 37. 
 
 

2. If the Rec # category is not displayed, open both references and check the 
record number at the top of the window before deleting any duplicate records 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Delete the reference whose number is not used in any of your unformatted of 
previously formatted papers. 

 
4. Close the reference windows once the correct references have been 

identified.  Click once to select the unused record, from the menu choose 
References, Delete or Edit, Clear.  The quick keys  + X or  + D for 
Macintosh or CTRL + X or CTRL + D for PC will also work.  
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5. A second chance window appears and click Delete. 
 

 
 
WARNING: Once a reference is deleted THERE IS NO UNDO FUNCTION.  Double 

check the references used in your unformatted papers before 
deleting. 

 

What if I delete a reference that was used in a paper? 
 

If a reference that had been inserted into a paper as a citation is deleted 
(inadvertently of course) EndNote will be unable to format the citation to the 
appropriate journal style.  For more information see Checking Mismatched 
Citations on page 34. 

 
• To correct this erase the deleted citation reference marker (including the 

braces) 

 
• re-insert the citation using the reference that was kept. The reference will 

look identical except for a different record number. 

 

#10  

Inserting EndNote Citations into a Document 
 

There are three different ways to insert a citation into the Word or WordPerfect 
document.  There is no difference in these citations to EndNote, so use the 
method you are most comfortable with. 
 
These steps place a temporary citation marker in the paper.  For example: 
 

{Bull, 1976 #22} 
 

It will not match the style needed for journal submission until the appropriate style 
is chosen in EndNote and the paper has been formatted to reflect that style.  The 
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final style formatting isn't usually done until you have completed writing your 
paper and are ready to create your bibliography. 
 

 
Note:  DO NOT type over top or change any part of this temporary citation marker.  Any 

editing risks breaking the link to the EndNote library and EndNote cannot find it.  
Therefore, the citation will NOT be correctly formatted when the final paper is 
formatted to fit your journal's styles.  

 
 

Before inserting a citation always ask these two questions: 
 

1. Have you highlighted the reference(s) in your EndNote library? 
 

a. Click on a single reference. 
b. Several consecutive references: click on the first, hold down the Shift 

key and click on the last reference 
c. Several non-consecutive references:  click on the first, hold down the 

 on the Mac or the CTRL key on the PC on the remaining references 
you will need to cite. 

 
2. Is the cursor in the correct place in the document? 

 
If the answer is "yes" to both questions proceed with inserting the citation. 

 

Four methods for inserting a citation 
 

Method 1 
 

1. Open the EndNote Library and highlight the reference(s) to be cited. 
 
2. Open the Word document and place the cursor where the reference(s) 

citation is to be placed. 
 
3. From the Word menu, select Tools, Insert Citation(s). An example of 

how It will appear: 
 
This is my great new idea and others have agreed 
with my findings{Bull, 1976 #9}. 

Or 
3. From Word, Click the Insert Selected Citations button on the 

EndNote toolbar 
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This marks the spot on the document where the formatted citation will be placed 
and from which EndNote reference the corresponding bibliographic information is 
generated.  

 
 

Method 2 
 

1. Open your document and place the cursor where the reference 
citation(s) is to be placed. 
 

2. Open the EndNote library and highlight the reference(s) to be cited. 
 

3. From the EndNote menu, select Add-In, Insert Citation(s).  The 
reference citation will appear as: 

 
This is my great new idea and others have agreed 
with my findings{Bull, 1976 #9}. 

 
 

Method 3 
 
 

1. Open the EndNote {Lumbiganon, 1996 #4}library and highlight the 
reference(s) to be cited. 

 
2. Choose Edit, Copy from the menu (or use the quick keys  + C for 

Macintosh or CTRL + C for the PC). 
 
3. Open the document and place the cursor where the reference 

citation(s) should be placed. 
 
4. Choose Edit, Paste from the menu (or use the quick keys  + V for 

Macintosh or CTRL + V for the PC). 
 

Method 4 
 

1. Open the EndNote library and highlight the reference(s) to be cited. 
2. Place cursor over selected reference(s) 
3. Click, hold and drag to the Word document. 
4. place the vertical dotted line where you want the citation 

and release 
 

The markers look and act identically regardless of which of these four methods 
are used to insert the reference citations. More than one library may be used in 
the same paper and any of these three different methods can be employed when 
choosing entries from the different EndNote libraries.  
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Turning off the CWYW tool 
When you insert a citation and it is automatically formatted and the bibliography is 
created the CWYW tool is active. 
 

1. Go to EndNote 
2. From the Tools 

menu choose Cite 
While you Write 

3. Slide over and 
choose CWYW 
Preferences 

4. From the CWYW preferences window deselect the Enable Instant 
Formatting on new Word Documents. It will 
gray out the two other check boxes 

 
 
 
Remember to have all used libraries open when formatting the paper otherwise 

EndNote cannot gather the necessary information to build the final 
citations and bibliography to match the chosen style. 

 

Formatting Citations and Creating a Bibliography 

 
After building the library, writing the paper, and inserting the temporary citation 
markers, the next step is to generate the bibliography to complete your paper.  
There are two choices: 

 
1. Format a copy of the original document and save it in the style chosen 
2. Format the original document in the style chosen. 

 
As always it is a good habit to keep a copy of the unformatted document. 

 
 

Choosing a Journal Style 
 

Although there are over 30,000 journals published around the world, EndNote has less 
than 700 journal formatting styles to choose from.  This is because many journals use 
the exact same bibliographic formatting style.   

 
The first step is to check the styles built into EndNote to determine if there is a 
preformatted style for the particular journal to which you will be submitting. The 
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window that displays the styles is called Style Manager.  There are two ways to reach 
Style Manager and both produce the same results.   

 

Selecting Journal Styles:  
 

Method 1 
 

Current Style 

1. Use the Main toolbar located below the menu items.  The current style is 
displayed in a field to the right of the toolbar. 

 
 
Note: If the toolbar is not visible it can be displayed by, from the menu items, choosing 

Edit, Show Toolbar.  This shows three toolbar options.  The MAIN toolbar is the 
one needed for styles. 

 
2. Next click on the double arrow or triangle to the right of the current style field.  

The drop-down menu provides three types of choices 
A. Select Another Style opens the Style 

Manager. 
B. If the style has been used before it will appear 

in the lower list and can be chosen at this time 
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3. The Style Manager displays all the styles in alphabetic order.   

• Type in the first letter of the journal you are looking for and the Style 
Manager will go to that section of the alphabet. 

• Click on a style to highlight it and then click the Choose button in the 
lower right. 

 
 

Now the style is displayed in the current style field and will be the default style 
when formatting the bibliography. 

 

 
 

Note: If the required style is not found or the style does not match the examples 
provided by the publisher then a custom style must be made or an alternate style 
found.   

 
 a style has been used before, it is NOT necessary to do step one (either Method). The 

hen the formatting process is started in Word a Format prompt appears and asks for 

If
reason for this is that it will already be on the style list.   
 
W
confirmation that the style selected is correct.  A drop-down menu is available at this 
time with the same list of styles that are on the Current Styles menu on the Main 
Toolbar in EndNote.  As long as the style is on that list it can be selected then. 
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Method 2 
 

1. From the menu items, choose Edit, 
Output Styles.   

2. A menu appears and the third 
choice is Open Style Manager. 

3. Select Open Style Manager 
 

 
 
 
 
 
 
 
Note: If the style has been used to format previous papers, then it will appear as 

a choice on the lower half of the menu and can be selected again.  
Otherwise, select Open Style Manager. 

 
4. The Style Manager displays all the styles in alphabetic order.   

• Type in the first letter of the journal you are looking for and the Style 
Manager will go to that section of the alphabet. 

• To select a style click in the left column so that a check mark appears.  
A style is NOT selected just because it is highlighted. 
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5. When the correct style is checked, close the window by clicking the little box in 

upper left (Mac) or the X in upper right (PC).  DO NOT choose Edit or Cancel. 
 
Note:  Once a style has been chosen from the Style Manager it will be available from 

the Current Style menu or the File, Output Styles menu. 
 

Viewing a Journal Style before formatting the document 
 
Use the Show Preview option to look at a reference formatted by the current style 
 

1. Set the current style to the one you want 
2. Open the Show Preview window at bottom of Library 

Mac: located at lower left 
PC: located at lower right 

3. Select a reference by clicking on it once 
4. View the reference as it will appear in the bibliography 
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Matching a Style Not Found in Style Manager 

 
If the style name of the journal is not listed in the available EndNote Style 
Manager, then take advantage of EndNote's Style Finder on their web page.  
There are only so many ways to list author, title and year so chances are the 
style demanded by the journal has a match by a different name or is a new style 
added since the original release of your EndNote version.  

 
http://www.endnote.com/support/enstylesfinder.asp
 

 
 

The Style Finder asks the following questions.  Answer only the ones necessary.  
Ignore the first two fields: Journal/Publication Name and Discipline. 

 
Usually the In Text Citations, First three fields, and Bibliography Sort Order 
questions are enough to provide a good search. 

 
The search provides a series of styles that fulfill the query. Below is an example 
search result.  
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The found styles show examples of a Journal Article, Book and Book section. 

• Compare the examples of each style to the specifications of the Journal 
until a match is found.  

• Do not download the style. 

• All the styles included in these lists are built into EndNote so once a style 
is identified select the style in EndNote’s Style Manager. 

 
If the found style is not in the Style Manager 

• then download it by clicking the appropriate version (Mac or PC) for the 
computer EndNote is installed on. 

• The new style file must be placed in the Styles folder on the hard drive 
before is appears in the Style Manager and can be used by EndNote. 

• You may have to restart EndNote for the choice to appear after moving 
the downloaded style into the correct folder on your computer. 

 
Below are listed the most common locations for the styles folder.  It is a folder 
that is inside your EndNote program’s folder. 

 
• On the PC:  C:\Program Files\EndNote\Styles 

• On the Mac:  Macintosh Hd\Applications\EndNote 7\Styles 

Changing the Journal Style 
 

If on the odd chance a manuscript is unappreciated by a publisher (rejected) changing 
the style to submit to a different (more enlightened) publisher is painless.   

 
1. Follow all the steps necessary to locate, select, and preview the new style as 

described starting on page 27 of this manual. 
2. Remember to have all libraries open that were used for inserting citations into 

your paper. 
3. Switch to your paper in Word or WordPerfect. 
4. At this point you may unformat citations to remove the bibliography style by 

choosing Tools, Unformat Citations from the menu items or you may format 
over the existing formatted style. 

Choose Tools, Format Bibliography from the menu items.  Then proceed with all the 
steps to check the accuracy of the new style outlined in the Formatting Citation section 
on pages 33-34. 
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Checking Citation Matches 
 
Now the paper is formatted and the Bibliography is visible and it must be checked for 
accuracy.  The first window to check is the Add-in Matches window.  This is located in 
the EndNote program so return to the program from Word.  This window shows the 
number of matched citations and unmatched citations found in your paper.   

 

The real value of this window is the lower field where each reference is individually 
listed.  A successful match will have a 1 in the matches column and the temporary 
citation to the right. 

 
A mismatched reference will have a 0 in the matches column.  This window allows for 
a quick assessment of the mismatched references to see if they were in fact citations.   
 
 

EndNote does not change the temporary citation marker or scientific notations within 
braces in your document if it cannot find a match, instead it leaves them alone.  So if, 
by looking at the Add-in Matches window, it is determined that the misses were not 
citations to begin with, then no further editing is necessary.  These mismatches can be 
ignored since they were never references to begin with. 

Note: EndNote sees all text inside of curly braces { } as a citation and will try 
to match a library reference to it.  So any scientific notations within 
braces will be mistaken as citations and marked as unmatched.  
Please ignore those particular items. 

 
If the mismatch is indeed a reference to a citation, then proceed to the Edit, Add or 
Delete Citations section after you check the style formatting for your citations and 
bibliography. 
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Common EndNote Preferences and Their Locations 
 

You may want to make small changes to the set up and default choices made by 
EndNote.  There are two preference sections in EndNote: 

 
1. EndNotes Main Preferences 
 
2. EndNote Add-In Preferences 

 
This appendix lists some common questions about customizing your version of the 
program and shows where to make the changes.  The list is primarily for reference 
and does not provide detailed instructions.  

 

EndNote's Main Preferences 
 

To access EndNote Preferences: 
 

1. From the Edit menu choose Preferences (at the bottom of menu). 
 

2. The Preference window has a list of categories on the left hand side.  Your 
options for setting preferences will be to the right.  These options will 
change to reflect the category you choose. 

 

To Save or Discard your Changes. 
 

While each category will have different choices, all the categories have the same 
options at the bottom of the window: 

 
EndNote Defaults: Returns the settings for the current window (ONLY) to the 
original EndNote settings. 
 
Revert Panel:  Removes any changes made to the current panel since it was last 
saved. 
 
OK:  Saves all changes to the preferences and loses the Preferences window. 
 
Cancel:  Discards all changes to the preferences and closes the Preferences 
window. 
 
Apply: Saves and applies all changes to the preferences, and keeps the 
Preferences window open so that you can continue to modify the preferences as 
necessary. 
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Library preferences 
 

• Add Field to Reference Type (see Edit Reference Type) 
• Add Reference Type (see Edit Reference Type) 
• Delete Field from Reference Type (see Edit Reference Type) 
• Delete Field from Reference Type (see Edit Reference Type) 
• Rename Field in Reference Type (see Edit Reference Type) 

 
Library default to open when EndNote opens: 

a. Open desired library 
b. Choose Library category, Add Open Libraries 

 
Font Default for reference display: 

a. Choose Display Font  
b. set Library display font. 

 
Font Default for typing references: 

a. Choose Display Font 
b. Set General Display Font 

 
Reference Type default.  When creating a new reference what type should it 
open? 

a. Choose Reference types 
b. Set the default type 

 
Edit Reference Type.  To add/ delete or modify fields.  Also to add or remove 
complete types. 

a. Choose Reference types 
b. Click the Modify Reference Types 
 

Display fields:  To change the order of the display or substitute a different field. 
a. Choose Display Fields 
b. Use pull down menus to modify display 

 
Capital letters used in a word such as DNA:  To keep EndNote from changing 
these words. 

a. Choose Change Case 
b. Enter Word to be ignored and Add. 

 
Sort Author's name:  To ignore certain words: 

a. Choose Sorting 
b. Add words to ignore in Author window 
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Sort Title Name:  To ignore certain words. 
a. Choose Sorting 
b. Add words to ignore in Title window 

 
Formatting: Confirm style before formatting.  To remove this step 

a. Choose Formatting 
b. Deselect confirm button 
 

Formatting:  Merge duplicates in Bibliography.  To remove this option. 
a. Choose Formatting  
b. Deselect Merge button. 

 
Duplicates: To set field criteria for duplicate search, such as which fields to 
compare. 

a. Choose Duplicates 
b. Set search criteria. 

 
Term Lists:  To turn off typing suggestions for author's names so EndNote will 
not try to guess the name you are typing. 

a. Choose Term lists 
b. deselect suggest term box. 

 

Setting a Default Library 
 

To set a created library (or libraries) to open automatically as a default, there are 
five simple steps to follow.   

 
1. Open the EndNote library(s) that 

will be the default. 
 
2. From the Edit menu, select 

Preferences.   
 

3. Choose the Libraries option 
from the list on the left.  This 
window allows a library to be 
open when EndNote opens.  

 
4. Click on Add Open Libraries 

and the name of the library(s) 
opened in step one will appear 
in the blank field.  A number of 
libraries can be added to this list. 

 
5. When done click on Save.  
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Printing References 
 

When printing one, several, or all of the references they will be printed out 
alphabetically with no line breaks between each reference.  The name of the library 
and the number of pages appear in the header in bold. 

Basic Printing options 
 
 

1. Begin by selecting the references needed to print. 
 

a. For a single reference, single-click on the one wanted. 
 
b. For several contiguous references, click on the first record, hold down 

the Shift key for both PC and Mac and click on the last. Select non-
contiguous references by holding down the Control key for PC and 
Command ( ) key for Macintosh while selecting the references. 

 

c.  For printing all of the records, select Edit, Select All. The keystrokes 
are  + A (Mac) or CTRL + A (PC) 

 
2. Check that the current style is the one you want for displaying the reference. 

 
3. Choose File, Print or use the quick keys  + P (Mac) CTRL + P (PC) 

 
4. After selecting all it can be turned off by choosing Edit, Unselect All from the 

menu items.  + A (Mac) or CTRL + A (PC) deselects all. 
 
Note: The reference will be printed as a bibliographic entry in the current style. 
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Advanced Printing options 
 

It is possible to have other fields such as Abstract or Keywords added to the 
reference when it is printing. These changes must be made to the Style layout.  
When the printing is finished the changes must be removed or the added fields 
will appear when the style is used to format a paper. 

 
Note: The easiest way to have the Abstract included is to use the Annotated style.  It 

is already set to include the abstract. 
 

To include other fields: 
 

1. From the menu items choose File, Output styles. 
 

2. This opens the available style list along with the choices to make a new 
style edit a style and open the style manager.  

 

 
 

3. Make sure the correct style for your paper is listed with the Edit choice.  
 

• If it is, then choose Edit "The style title here". 

• If it is not the correct style then slide down one choice and 
select Open Style Manager. For more information on the style 
manager see page 29 

• If it is not the correct style and the journal name is not in the 
style manager then proceed to the Matching Styles Online 
section on page 33.   
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4. The editing window opens with 

the categories in the left field. 
 

5. Open the layout field in the 
Bibliography folder.  There is 
a Start and End reference field, 
each with a pull down menu of 
field choices called Insert 
Field. 

 
6. Decide if the added field 

should appear before or after 
the reference and choose from 
the corresponding field. 

 
7. Select the Insert Field button 

that responsible for where you want to attach the extra field(s). 
 

8. Slide down and select the field you want. 

• Only the visible choices are available and you can insert 
multiple choices.  So both Abstract and Keywords, for example, 
can appear after the reference. 

 
 

Note:  Remember to remove the added fields after printing or they will remain part of 
the style and appear next time a paper is formatted with that style. 
 

Copying References 
 

It may be necessary to copy references from one library to another to build 
specific libraries for specific papers.  
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1. Select the reference (click to highlight in EndNote) and choose Edit, 
Copy from the menu (or use the quick keys  + C for Macintosh or 
CTRL + C for PCs). 

 
· For several contiguous references, click on the first record, hold 

down the Shift key for both PC and Mac and click on the last.  
· Select non-contiguous references by holding down the Control 

key for PC and Command ( ) key for Macintosh. 
 

2. Open or activate the library that will receive the reference(s) and 
choose Edit, Paste from the menu (or use the quick keys  + V for 
Macintosh or CTRL + V for PCs). 

 
EndNote automatically alphabetizes the newly added references and combines 
them with the old ones. 
 
Another reason to copy a reference from a library is to paste a citation in a Word 
document directly instead of using the Tools, Insert Citation(s) command. 

 
Note: A reference can also be moved from one open library to another by clicking, 

holding and dragging the reference to the target library. 
 

Temporary Citations 
 

All of the changes listed below can be made in the Temporary Citation section of the 
Preferences.  In each case the default preference will be indicated within parentheses 
at the end to the sentence. 

 
1. Change the Temporary citation delimiters from braces to another choice to avoid 

confusion with scientific expressions. ( {  } ) 
 

2. Change how record number markers are indicated (#). 
 

3. Substitute record number marker with a label.  Useful if collaborating with 
someone who does not use EndNote and would not recognize the temporary 
citation by number. 
 

4. Change Prefix Marker.  To separate a prefix from the citation itself.  ( \ ). 
 

5. Change Note indicator. ( NOTE: ) 
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EndNote Add-In Preferences 
 

This preference window is separate because it is concerned with how Word and 
EndNote interact.  EndNote add-in preferences can be reached in two ways: 

 
1. From Tools menu in Word choose EndNote Add-in Preferences. 
2. From Add-in menu in EndNote choose EndNote Add-in Preferences. 

 
This window allows: 
 

1. Open EndNote automatically when Word opens 
 
2. Close EndNote automatically when Word Closes 
 
3. Return to Word after inserting citation. 
 
4. Set keyboard shortcuts for:  

 
• Return to Word 

• Go to EndNote 

• Insert Citation 

• Format Bibliography 

• Unformat Citation 
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Editing Styles 
 
The Edit window appears with the name of the style on the title bar. 
 

 
The choices of which parts of the style to alter are on the left of the window.  Here is a 
brief explanation of the categories most used during editing a style. 
 

Templates: Shows the models EndNote uses to create entries. Click here to adjust 
a specific reference type such as Journal or Book. 

 
Author lists: Determines how many names to list and how to list them: such as the 

placement or omission of commas. 
 
Author name: Choose the order for names, such as Jane Doe or Doe, Jane, as well 

as initials with or without periods. 
 
Editor lists: Determines how to display Editor and multiple editors' names. 

 

Template Syntax Rules 
 

Direct adjusting to the style occurs in the template category for either the in text 
citations or Bibliography.  The concept of style editing is very basic: change the 
template to match the desired style.  The difficulty is in the syntax used by EndNote. 
Once the syntax is understood then customizing a style goes smoothly. 
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Rule #1: 
 

By default the Font, size and Style are all Plain forcing EndNote to match the font to 
the one used in the paper.  The Text menu allows these aspects to be altered.  For 
example to change a field entry to always appear in Italics highlight the field and 
choose Text, Style and Italics. 
 

 
Any text or punctuation not separated from a field name by an ordinary space is 
dependent on that field.  So the dependent text or punctuation only appears if the 
field contains data. 

 
Example: Volume (Issue) 

A reference with an issue = 28 (6) 
A reference without an issue = 28 

 
The parentheses around issue only appear if the entry contains an issue number. 

 
Note: There is also a text toolbar available under the Edit menu.  Choose  Show 
Toolbars, Text Style.  This toolbar is more convenient if extensive editing is necessary  
 

Rule #2: 
 

The preceding field takes precedence over the following field. Punctuation that 
appears between fields with no spaces is dependent on the first field. 

 
Example: Volume:Issue 

A reference with a Volume = 28:(6) 
A reference without a Volume = (6) 

 
If there is no volume in the reference then no colon will appear. 
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Rule #3: 
 

The first space after a field is dependent on that field.  Additional spaces are 
independent and will always appear. 

Author. Title .
Adjacent Punctuation 
considered part of the 
Author field. 

Dependent space: For the purpose of 
this illustration the dependent space is 
indicated by the large gray dot.   

In this illustration the space is dependent on the Author field. 
 

Example: Author. Title 
A reference with an author = Smith. No Way Out 
A reference without an author = No Way Out 

 
Without an extra space the title will be lined up with the left margin. 

 
Here there are two spaces between the period and Title.  So the first space will not 
appear if there is no author, but the 2nd space will appear. 

 
Example: Author.  Title 

A reference with an author = Smith. No Way Out 
A reference without an author = No Way Out 

 
That extra space will cause the reference margin to be uneven in the Reference List.  
With only one space if there is no author then the title will not have a space before it 
in the reference. 

 

Rule #4: 
 

Independent text always appears in the bibliography or citation.  Any text or 
punctuation not dependent on a field name always appears in the reference. 

 
Example: Edition ed. 

A reference with an Editor = Wilson W ed. 
A reference without an Editor = ed. 

 
Because only the one space after the Edition field is dependent, the “ed." is 
independent and will appear in all references regardless if there is a need for it.  This 
is corrected using special characters that allow you to break the rules. 
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Special Formatting Characters 
 
There are special characters that allow the rules of syntax to be bent and provides 
some flexibility to constructing templates. 
 

Option-space: Links text or Punctuation to a field.  This is created by: 
Mac: holding down the Option key while pressing the space bar 
PC: hold down the CTRL + ALT and press space bar. 

 
Example: Edition ed. 

A reference with an Editor = Wilson W ed. 
A reference without an Editor = ed. 

 
In the above example the "ed." would print in all references because it is independent.  
To ensure it will only appear when the Edition field is used it must be connected to it.  
Replace the regular space with an Option-space and the "ed." will appear only when 
needed: 

 
Example: Edition ed. 

A reference with an Editor = Wilson W ed. 
A reference without an Editor =  

 
Forced Separation: Separates text or punctuation that is dependent.  It is the 

opposite of the Option-space. The vertical bar is made by 
holding the shift  and hitting the backslash \ key. 

 
Example Volume.Issue (Year) 

A reference with an issue = 23.(2) (1998). 
A reference without an issue = 23.(1998). 

 
There are two problems with the reference without an issue. 

 
1. As written the period is connected to the Volume field, but if there is no Issue 

field the period is not needed.  The period is connected, however, and will 
appear unless it is changed. 

 
2. The space following the issue field is dependent on the issue field and will not 

appear if there is no issue allowing the year to sit on top of the period. 
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The solution is the same for both problems: 
 

1. A forced separation between the Volume field and the period will force the 
Period to be dependent on the Issue field. 

 
2. A second forced separation immediately after the Issue field will break the 

space away and allow it to appear between the volume and year when no issue 
is present. 

 
Example: Volume|.Issue| (Year) 

 
Field Names in bibliographies: When text is needed in the bibliography but is the 

same as a field name EndNote will read it as a field 
name.  This text must be tagged with Back 
apostrophes so EndNote will recognize it as text and 
not a field.  You can usually find this key at the top left 
of the keyboard near the number 1. 

 
Example: If the title "Editor" is to appear after the name of the editor then it 

must have back apostrophes around it.  Also remembering the prior 
situation, the text must be made dependent on the Editor field to 
avoid having it appear in every reference. 

 
So the final result is : Editor, `Editor` 

A reference with an Editor = Boy, Tommy, Editor 
A reference without an Editor =  

 
Singular/Plural Term Separator: Labels change if the field data is singular or 

plural and EndNote recognizes the difference.  
 

By using the Caret which is the symbol (^) typically found above the 6 key.  Most of 
the uses for this involve multiple editors or pages.  Enter both the singular and plural 
forms separated by the Caret (^).  Now all text prior to the caret up to the preceding 
space will appear in singular form, while all text after the caret including the first space 
will appear in plural form. 

 
Example: Editor, ed.^eds.  

A reference with an Editor = Wilson W ed. 
A reference with Editors = Wilson W and Boy T, eds. 

 
Tabs: Tabs are entered by Command + Tab for Macintosh (  + Tab) and  

Ctrl + ALT + Tab for PC 
 

The width of the tab is determined by the word processor tab settings. 
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Hanging Indents: The setting for Hanging indents is located in the edit style window 

under the Bibliography folder.  Choose Layout and the hanging 
indent menu is in the bottom right of the window. 

 
 

Custom Style Exercise 

 
In this exercise we will be creating a paper to be submitted to Cell, Death and 
Differentiation magazine.  We are only concerned during this exercise with the 
specifications dealing with citation and bibliography formatting. 

Gather Information from the Publisher 
 

The magazine's specifications read as follows: (Emphasis and Organization is added) 
 

1. The References should follow the Vancouver format. 
2. In the text, citations should appear as numbers starting at 1 
3. At the end of the paper the references should be listed (double-

spaced) in numerical order corresponding to the order of citation in 
the text.  

4. The first and last page numbers for each reference should be 
provided.  
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The following are examples of the reference style from their web page of 
instructions to authors (http://www.stockton-press.co.uk/cdd/instruct.html): 

 
1. Gottschalk AR, Boise LH, Oltvai ZN, Accavitti MA, Korsmeyer SJ, 

Quintans J and Thompson CB (1996) The ability of Bcl-XL and Bcl-2 

to prevent apoptosis can be differentially regulated. Cell Death 

Differ. 3: 113-118 

2. Feramisco JR and Welch WJ (1986) Modulation of cellular activities 

via microinjection into living cells. In Microinjection and organelle 

transplantation techniques, Celis JE, Graessmann A and Coyter A, 

eds (London: Academic Press) pp. 40-58 

 

Locating Style Provided by Publisher 
 
 

 
Note:  The style can also be viewed by selecting the Show Preview window in the 
lower left of the Mac library window or in the lower right on a PC. 
 
 

Finding a Style Using EndNote's Style Finder 
 

It becomes clear that EndNote's version of Vancouver is not the same as Cell so we 
will have to create a custom style.   

 
1. Create a new style from scratch  
2. Modify the version of Vancouver present in EndNote. 
3. Use EndNote's Style Finder to locate a style closer to the magazine's 

specifications. 
 

In this instance, the first option is a considerable amount of extra work.  Both options 2 
and 3 are good choices.  For the sake of the exercise we will first try to find a style 
closer by using the StyleFinder because in most situations we will not even have a 
style name to go by.  So we go to the web site 
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http://www.endnote.com/help/ENstylesfinder.htm 

 
It presents us with this search engine.  So we fill out the important information.  
Because we know we will be editing the style it is best not to limit the search to a 
journal name or discipline.   
 
From the journal’s author’s notes, we know the style requires superscripted numbers 
for in-text citations and that the first three fields are author, year and then title.  Next 
we select the order of the bibliography is sorted by their appearance in the paper.   

 
 
We select the necessary information for the citations, reference fields and sort order 
and then click search.  
 
After a delay as the StyleFinder searches the database it produces the results.  In this 
case 19 matches were found.   

 

 
We begin matching the examples shown to the magazine's examples until a close 
match is found.  We can check to see if the journal style in already in the Style Manager 
or we can choose to download a copy by clicking on the appropriate computer type 
(Mac or PC).  In this particular example, the style is already in the Style Manager we will 
not have to downloading the style.   
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Downloading a Style 
 
Use EndNote's Style Finder to locate a style closer to the magazine's specifications. 
 

http://www.endnote.com/help/ENstylesfinder.htm 
 

It presents us with the search engine where we fill out the important information.  From 
the journal’s author’s notes, we match the style for in-text citations and that the first 
three fields.  Next we select the order of the bibliography sorted as described by the 
journal’s author’s notes.   
 
Once you have chosen a style from the list that results from your search you will need 
to download the style and place it in the styles folder so it would be available to 
EndNote.  It may be a good idea to rename the style to reflect the name of the journal 
you are submitting to.  Otherwise you may have to make a note on paper somewhere 
that the Style you chose to download works for your particular journal. 

 
Location of Styles folder: 
 

Mac: Macintosh HD/applications/endnote 4/Styles 
PC: My Computer \C:\Program Files\EndNote 4\styles 

 
Choose the style in the Style Manager by either choosing select another style from 
the Current styles menu found on the Main toolbar or from the Menu item File choose 
Output Styles, Open Style Manager. 
 

 
After choosing the correct style, go to File on the menu and choose Output Styles.  
Make certain the style we wish to edit is selected and choose Edit "the name of your 
style here"  

 
For this exercise we will choose Edit "Amery J Tropical Medicine". 
 

This opens the edit window.  The categories for editing are on the left side of the 
window and the details of whichever category is on the right.  So with each category, 
expect a change in the window on the right. 

 
 

The Bibliography Template 
 
Most of the major changes can be made using the Template category.  Choose the 
Templates in the Bibliography folder and focus on the Journal Article because in most 
papers here at NIEHS, most of our citations are from journals.   
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Compare the Journal Article Template to the author’s notes sample. 
 

 
1. Gottschalk AR, Boise LH, Oltvai ZN, Accavitti MA, Korsmeyer 

SJ, Quintans J and Thompson CB (1996) The ability of Bcl-
XL and Bcl-2 to prevent apoptosis can be differentially 
regulated. Cell Death Differ. 3: 113-118 

 
In this example, the year is missing from the Journal Article Template and must be 
added. 
 

• Insert the year field in between the author and title.  Place the cursor where you 
want the field to be added.   

• When the cursor is in place the Insert Field menu becomes active.  Click on the 
arrow and choose the desired field. 

 

 
 

Note:  If the field we want is not present then copy and paste the field from another 
reference type or type it in directly.  Do not forget the dependent space after the 
Year. 
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The Book reference: 
 
Compare the Book Section Template to the author’s notes sample. 
 

 
 

2. Feramisco JR and Welch WJ (1986) Modulation of cellular 
activities via microinjection into living cells. In Microinjection 
and organelle transplantation techniques, Celis JE, 
Graessmann A and Coyter A, eds (London: Academic Press) 
pp. 40-58 

 
Everything is fine except: 

 
1. The Editor field and book title field need to be switched  
2. The text labeling the pages needs to be added  
3. The period removed from the end. 

 
Edit the formatting for this journal style’s Book Section by doing the following: 
 

1. The Editor field can be moved by highlighting from the capitol "E" in Editor 
to the independent space after the Forced Separation (indicated by the 
vertical line).  

 
2. Next Cut the Editor selection and Paste immediately after the 

independent space following the Title field. 

3. The next step is to add the text labeling for the page numbers.  Because 
the page field can produce either a singular or plural value we have to give 
the field two options to choose from.  This is accomplished by using the 
caret symbol (^).  Place the cursor between the independent space after 
the Publisher field and the Capitol "P" of Pages 

 
 

4. Now type in the singular option including punctuation. 
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5. Type in the caret symbol ^. 
6. Add the plural option including punctuation. 
7. Finish by adding a connecting space so the text label will be attached to 

the Pages field.  On MAC hold down Option and hit the Space key.  On 
PC hold down the Ctrl + Alt keys and hit the Space bar.  Do not forget 
to delete the period at the end of the reference and we are finished the 
Book Section. 

 
The other reference types are fixed in this fashion.  Choose File, Save as and rename 
the style so we do not lose the original.  Be sure the file is saved to the Styles folder in 
the EndNote program. 

 
Location of Styles folder: 

 
Mac: Macintosh HD/applications/EndNote 4/Styles 
PC: My Computer\C:\Program Files\EndNote 4\styles 

 
Once the Bibliography Templates are corrected then check the Citation Template. 
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The Citations Template 
 

The Citations Template is much simpler and in this case only contains one field.  It is 
the bibliography number and is superscript.  Notice that if a field was needed the insert 
field would be available once the cursor is placed in the test window. 
 

 
 

A second choice on this window is deciding the punctuation used to separate multiple 
citations.  Presently the style uses a comma for that and to edit this highlight and type 
the desired punctuation in the field. 

 

Fine-Tuning Styles 
 

We are finished with the templates for both categories.  In both the Citation and 
Bibliography folders there are more categories for fine tuning the style.  We will now 
take a quick look at each category starting with Citations. 
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• Ambiguous Citations: 
 

 
This category helps make a citation unique when not enough information is 
available for the regular citation or to separate two similar references from each 
other. 

• Author Lists 
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This category allows you to decide how to separate authors, and what to have 
before the last author.  It also allows you to adjust the number of authors listed 
and how to abbreviate. 
 

• Author's Name 

 
This category allows you to choose how the authors name will be displayed and 
what punctuation to use with initials.  It also provides a way to handle 
consecutive citations by the same author. 
 

• Numbering 

 
For this exercise the Numbering category will be the only one of interest because 
the citations are only numbers. Here you can decide how consecutive citations 
will be displayed.  We want them to be shown with a dash between the first and 
last number instead of each one listed.  So check the number range box. 
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• Sort Order 
 

 
As a rule of thumb the sort order will stay the same as the Bibliography and any 
specific order can be established in that folder instead of in the Citation folder. 

 
 

Bibliography:   
 

Following the same pattern we will check all the categories for the Bibliography folder. 
 

• Author lists 

 
This category allows you to decide how to separate authors, and what to have 
before the last author.  It also allows you to adjust the number of authors listed 
and how to abbreviate. 
 

 

• Author name 
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This category allows you to choose how the authors name will be displayed and 
what punctuation to use with initials.  It also provides a way to handle 
consecutive citations by the same author. 

 

 

• Editor lists 
 

This category has the identical choices as the Author lists window. (see above) 
 

• Editor name 
 
This category has the identical choices as the Author name window. (see above) 

 
• Layout 

61   



 

 
This category is where you can add or remove numbering from the reference list 
as well as add a missing field.  Layout is where we can affect the first tabs and 
hanging indents as well. 

 
This category is also used for attaching a field for special printing situations.  See 
Advanced Printing on page 

 
• Sort Order 

 
 

Sort order allows us to decide how to order the Bibliography. 
 

There are two categories not included in the Citation or Bibliography categories that 
may be of some use in further editing. 
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Page Numbers: 

 
When a style is specific about how the numbers should be shown this category allows 
access to the various options. 

 

Journal Names: 
 

Finally if there is any trouble with journal names and how they are being displayed 
then check in the Journal Names category near the top of the menu. 

 
 
 

That completes our editing of this style and it is ready to go.  Close the window and it 
will prompt you to save changes.  Do so and proceed to format the paper in the usual 
manner. 
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APPENDIX 
 

Basic Library Searches and EndNote 
 

 65



 

NIEHS Library Photocopy Request Instructions Part 1: 

 
When using library databases, users have the ability to select bibliographic 
references and send them to the NIEHS Library. The Library then copies, or 
arranges to copy, the full text of the requested article and sends the paper copy 
to the user. 

 
For each database platform, follow the instructions given to mark and download 
selected records. 

 
 

Protocols for Exporting References to EndNote 
 
 
PubMed 

 
1. In PubMed, be sure to display your selected search results/references in “MEDLINE” 

format.  (Note: the default format is “summary.”)  Also adjust the “Show” (under 
“Display) pull-down menu to accommodate the number of “items” in your search results.  
Next, you will want to “Display” all your records to capture all “items” to file.     

2. Once the “items” are displayed in MEDLINE format, click on the “Save” button and save 
as a text (*.txt) file. 

3. Open End Note and then open your library file. 
4. From “File” menu item, select Import. 
5. In the Import dialog box, the first step will be to “Import Data File.”  Using the CHOOSE 

FILE button, select the text file you saved in PubMed. 
6. The second step is to select an “Import Option.”  For PubMed select “Other Filters…” 

Then highlight the PUBMED (NLM) filter and click on the CHOOSE button.  
 
 
Web of Science  
 

1. First, you should have an EndNote library ready to receive your Web of Science 
search results. 

2. Mark desired records in your (Web of Science) Search Summary and click SUBMIT 
button. 

3. Click MARKED LIST button (near top of screen).  Select format/fields (abstract, 
keywords, address, etc) you want citations to have in EndNote.  This is at the bottom 
of your screen.  

4. Click EXPORT.  This will load EndNote, select appropriate Library, records will 
import automatically. 
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Biological Abstracts OVID Database System   
  
(These instructions apply to other OVID databases such as AGRICOLA, MEDLINE and 
PsycInfo.) 
 

1. First, you should have an EndNote library ready to receive your search results. 
2. Conduct search.  Click on the blue DISPLAY button. 
3. Click on CITATION MANAGER. 
4. Under CITATIONS, select range of items you want to export to EndNote. 
5. Under FIELDS, select data elements you want to export to EndNote. 
6. Under CITATION FORMAT, select REPRINT/MEDLARS. 
7. Under ACTION, select SAVE. 
8. Under SAVE CITATIONS, select the “LINEFEED” that matches your situation and click 

on the green CONTINUE button.  This should save your file to disk. 
9. Open EndNote and then open your library. 
10. Repeat steps 4-6 under PubMed at the top of this page; however, in this case you 

highlight the Medline (OVID) filter instead of the Medline (NLM) filter. 
 
Porpoise Searches Delivered Weekly by E-mail 
 

1. You should have a library (file) established in EndNote to receive your search results. 
2. Open the Porpoise e-mail message with “Matches Found.”  “Matches Found” is a list of 

your weekly search results in Porpoise.  Look through the list of records.  You will want 
to “Mark” each record to be exported to EndNote.  This is done in the following manner.  

3. Locate the first record you want to export to EndNote.  Click on the URL that starts with 
http://porp.cit.nih.gov/isicgi/gateway/Gateway…………. 

4. After you click on the URL, Porpoise will take you to the record of this citation in Web 
of Science. 

5. Click on MARK, located in a blue box at the top of the page.  You will note this adds this 
record to MARKED LIST. 

6. To add more records from your Porpoise search, go back to “Matches Found.”  Click on 
the URL of another record as you did in steps “2” through “4” above.  Click on MARK in 
the blue box and you will add another record to your MARKED LIST.  Records will 
accumulate in MARKED LIST until you have added everything you want to export to 
EndNote.  Now you are ready to export items from Marked List to EndNote. 

7. Click on MARKED LIST. Select format/fields (abstract, keywords, address, etc.) you 
want citations to have in EndNote.  This is at the bottom of your screen. 

8. Click EXPORT. This will load EndNote, select appropriate Library, records will import 
automatically. 

 

 67



 

 
BasicBIOSIS - OCLC FirstSearch Database System 
 
(These instructions apply to other OCLC FirstSearch databases such as AGRICOLA and 
WorldCat.) 

 
1. First, you should have an EndNote library ready to receive your search results.  You 

should also make sure that you have the appropriate filter installed in EndNote.  To do 
this, choose File, Import Filters, Open Filter Manager.  Look at the alphabetical list and 
check for the filter of the database you plan to search.  In this case, be sure that 
“BasicBIOSIS (OCLC)” filter is installed.  If the correct filter is not already installed, 
visit http://www.endnote.com/support/enfilters.asp to download it.  Save the filter to 
C:\Program Files\Endnote\Filters.  If you have the “Filter Manager” window open when 
you do this, close and reopen it to refresh the list of import filters. 

2. Conduct the search in the database.  On each page, mark the desired records in the search 
results. 

3. After marking records on the last page, click on the blue “Export” button on the top 
navigation bar.  

4. Verify that the radio button for “Marked records” is chosen.  Click the gray “Export” 
button. 

5. EndNote will load automatically.  A dialog box will open, enabling you to choose the 
EndNote library that you created to receive your results.  Select the appropriate library 
and click “Open”. 

6. Another dialog box will appear, prompting you to choose an import filter.  You will need 
to choose the filter that corresponds to the database in which you conducted your search.  
Since this search was conducted in the BasicBIOSIS database provided by OCLC, choose 
the “BasicBIOSIS (OCLC)” filter.  If you were to search another database provided by 
OCLC, such as WorldCat or Agricola, you would choose filters that correspond to those 
databases.  

7. Once you have selected the appropriate filter, click the “Choose” button.  Your records 
will be imported into EndNote. 
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